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Print Sequencing

In this lesson, we’re going to talk about a concept related to printing. This will not 
be about the technical aspect of printing. Instead, we’re going to learn how to 
plan a layout of images.

When planning to print a series of images to hang on your wall, either in a row or 
some sort of arrangement, it’s important to think about which images would be 
appropriate, what size they should be and which images should go next to each 
other. 

Viewing Distance (Timestamp 1:34)

Note that there is a separate Masters Academy lesson on determining the optimal 
size and viewing distance for your prints. That lesson includes a special spread-
sheet that will help you to calculate the best print size and resolution based on 
your ideal viewing distance. This spreadsheet is also customizable so you can en-
ter in your own desired print sizes. A link to this lesson is included on the course 
page. 

The above spreadsheet will help you to calculate the ideal print size for a specific viewing 
distance. You can download it from the course page for the “Resolution & Print Size” lesson.
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There is a certain viewing distance from which it is ideal to enjoy prints. If you’re 
forced to view the print from too close a distance, you will be forced to look at 
the fine details of the image and you won’t be able to take in the full expanse of 
the print. I will often use this idea to limit the size of my prints, depending on their 
environment. 

Let’s say I have a wall space that is 40 inches wide and I would like to hang a print 
there. The first thing I would do is stand in front of the wall at a comfortable view-
ing distance from where the print would hang. In this case, the wall is in a hallway 
so I will be close to the wall by default. I’ll measure the distance between my eyes 
and the wall. In this example, the distance is 16 inches. Then I’ll open the print size 
spread sheet. On the left of the spreadsheet, there is a list of various print sizes. 
Two columns to the right, there is a category titled “Whole Print Viewing Distance 
in Inches.” This tells you how far you’d need to be from the chosen print size in 
order to take in the entire print without turning your head left and right. 

The distance I had measured in the hallway was 16 inches. In that location, I would 
need to be viewing the print from 16 inches away. Knowing this, I will look down 
the “Whole Print Viewing Distance” column and see if any items read 16 inches. 
I don’t see any items that read 16 inches. This means that the chart contains no 
print size that is small enough to be easily viewed from 16 inches away. The small-
est print on the chart is 16” x 16” and I will need a print that is smaller than that.

I’d like to see what the viewing distance would be 
for a 13” x 13” print so I will click within the first print 
dimension field and change the dimensions from 16” 
x 16” to 13” x 13”. I’ll click away from the cell so that 
the chart updates and then I’ll look at the “Whole 
Print Viewing Distance” field. It now reads 14 inches, 
which means that in order to ideally view that print 
size, I’d need to be at least 14 inches away. This tells 
me that my 13”x 13” print would be a good size for 
that wall. 

I changed the first Print  
Dimensions cell to 13x13 to 
see what the ideal Whole Print 
Viewing Distance would be for 
a print that size. The viewing 
distance is at least 14”.
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Now let’s look at a bigger space that will display a series of prints. This example is 
another hallway in my house, but it’s much longer. In the video, I am showing you 
the space via a 3D model of the house I created using a program called SketchUp. 
In your own space, you can easily just walk around with a tape measure. The 3D 
model will simply be an easier way for me to show you the space without needing 
to walk through the house with video cameras. 

In my hallway, the width is 3’8” wide. I used the program’s measuring tool to de-
termine this, but again, you could simply take a measuring tape to find the size of 
your own space. The total width of my hallway is 3’8” but that’s not the distance 
from which I’ll be viewing the prints there. My viewing distance will probably be 
closer to 2’. I now need to figure out how big of a print I can have if I want to view 
it from about 2’ to 2.5’. I’ll go back to the print size spreadsheet and look down 
through the third column, “Whole Print Viewing Distance in Inches.” The closest 
figure to my ideal distance is 25.8” and that is for a print that is 24” x 24”. Another 
similar distance is 23.7” and this is for a 20” x 24” print. This gives me a good sense 
for how large of a print I can hang in the hallway where I can enjoy the entirety of 
it from my ideal viewing distance. 

In this 3D model of my house, we are viewing the overhead view of the hallway where I would 
like to hang a series of prints.

3’8”
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Selecting Images for Printing (7:27)

Setting a target collection Now let’s talk 
about how you can go about choosing 
which images to print for a certain lo-
cation. For my house, I created a collec-
tion within Lightroom. In this collection, 
I placed all of the images I would con-
sider for printing and displaying in my 
home. To make this easier, I designated 
this collection as the “target collection.” 
The target collection is the one that an 
active image will be placed into when 
you tap the B key.  By default, this is the 
Quick Collection. If you designate an-
other collection as the target collection, 
you can quickly populate the collection 
by moving through your images and tapping the B key for all images you want 
to place in the collection. To designate a collection as the target collection, right-
click on the collection name and choose “Set as Target Collection” from the pop-
up menu. When a collection is set as the target collection, a little plus sign (+) will 
appear next to its name in the Collections panel. 

Choosing a sequence of images I want to 
choose a series of images to use in a sequence, 
but I need to determine which images would 
look good together and what order they should 
go in. I also need to see if there are any adjust-
ments I need to make to the images in order to 
make them look better together. 

Looking through the collection I created of po-
tential images, there is one that my eye is im-
mediately drawn to. It’s a very colorful images 

Right-click on the name of a collection and 
this menu will appear, giving you the option 
to set this collection as the target collection.

I know I want to include this image in 
the print series, so I’ll look for other 
images that share similar features.
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of a vintage motel with lots of neon lighting. I would like to use this image as one 
in a series, but I need to make sure that the other images in the series look good 
with it. To ensure this, I’ll look for images that have similar colors or similar satu-
ration. There is another image that has the same color of twilight sky so I’ll drag 
the images next to each other in the collection so that I can see them side by side. 
Looking through the collection, I’ll take all the images that have a similar color of 
sky and I will drag them next to each other in the collection. 

Survey View Next, I will select all of 
the images I had grouped together 
(the images with similar skies) and 
I will click on the Survey View icon 
that is located on the left side of the 
toolbar that runs below the image 
window (see screen shot). This will 
take all of the selected images and 
show them together in a multi-image comparison view. I know that I want to keep 
the original neon motel image so I’ll consider this the key image. In this view, I’ll 
look through the other images to see which ones I think best go together. 

In my Lightroom collection, I looked for all images that had similar sky colors and dragged 
them together. 

The Survey View will take all selected images and 
put them in the same window for comparison.
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Looking at the images, one of them looks like it has 
a daytime sky, where all of the others are night skies, 
so I don’t think that one will be good for the series. I’ll 
hover my cursor over the bottom right corner of the 
thumbnail and an “X” will appear. I’ll click on the X to 
remove this image from the survey view. This does not 
remove the image from the collection. It simply dese-
lects the image so that it does not appear in this view. 

While in the survey view, I can drag the images around to reposition them. This 
gives me a better idea of which images look good next to each other. There is an-
other image of a building that has neon and the same sky color so I will drag that 
next to the motel image. These look great together so I know I’ll keep that one. 

Continuing to evaluate the other images, I think that the iguana image and the 
water image both have more of a daytime feel even though the color of the sky is 
similar to the other images. Since I’m moving toward a nighttime theme, I’m going 
to remove these images as well. 

All of the selected images have been placed in the Survey view.

Click the X to remove an 
image from Survey view.
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NOTE: When evaluating a set of images like this, it’s important to remember that 
you can always adjust the images in order to make them match better. 

I want to evaluate these images based on both visual similarities and subject mat-
ter. I’ll remove some of the images because they differ too greatly in subject mat-
ter and others because they are visually too different. At the end, I have three 
images that I think work really well together. They all feature old, vintage-style 
buildings at dusk and they all contain some vibrant neon. 

Now that I have my selections, I’ll return to Lightroom’s Grid view. I can do this by 
tapping the G key or by clicking the Grid view icon on the left side of the toolbar 
below the image window. 

Choosing the Image Sequence (23:36)  

I now know what images I’m going to print 
for the hallway, but I still need to decide 
what order they should be hung in. To de-
termine this, I will look at the shapes in the 
individual images. Your eye will naturally be 
drawn to certain areas of an image and it 
will move across the image in a path de-
termined by a few different factors. In the 
service station image, my eye is first drawn 
to the vertical spire and then it moves down 
along the line of the building toward the sun 
on the right side of the image. Noticing the 
way my eye moved through the scene, I can see that this would be a good image 
to put on the far left because my eye moves to the right and it takes me into the 
rest of the series. 

In this image, my eye is drawn to the tall 
spire and then it moves down, along the 
edge of the building, toward the sun.
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I’ll look next at the photo of the Blue Swallow Motel. Here, my eye is first drawn to 
the big sign in the upper right and then it moves down to the building on the left. 
This tells me that this image would work well on the right end of the series be-
cause it will pull the viewer to the left and into the series. The angle of the building 
emphasizes this as well because it angles downward toward the left. 

Adjusting the Images (25:08)

Before printing the three selected images, I will first adjust them to ensure that 
they truly feel like they go together. I think that the skies are going to be the el-
ement that really pulls the images together so I want to make sure that all three 
skies match really well. The sky in the center motel image does not look like it 
matches the other two images so I’ll need to shift the color a bit. 

Reference View I’ll open that image in the De-
velop Module in Lightroom. Then, below the 
image window, I’ll click on the Reference view 
icon (R|A). This will split the screen into two 
windows with the active image on the right 
side. I will locate one of the other chosen imag-
es (one with the ideal sky) within the Filmstrip 
at the bottom of the interface and I will drag it into the window on the left. This is 
the reference window. Now, I can use the adjustment sliders to make changes to 
the active image on the right while looking at the reference image on the left. This 
will allow me to better match the active image to the image on the left. 

This is the sequence in which the images will be hung on the wall. 

In the Develop Module the Reference 
view icon can be found in the toolbar 
below the image window. 
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If you wanted to adjust the image in Photoshop, you can get a similar compari-
son view. With both images open in Photoshop, click on the Window menu and 
choose Arrange > 2-up Vertical. This will place the two image windows side by 
side so that you could work on one image while comparing it to the other. After 
you’re done adjusting the image, you can get back to the regular 1-window view 
by again clicking on the Window menu and choosing Arrange > Consolidate All 
to Tabs. 

Other Ways to Sequence Images (28:00)

Let’s look at some other concepts relating to sequencing images. I shoot a series 
of images with the common theme of vintage trailers. They are all light paintings 
and they’re all shot at night, so I think they would display well together. I would 
like to find the best way to display these on a wall. 

This is the Reference view in Lightroom. The active image is on the right. This is the image 
that will change when the adjustment sliders are moved. The image on the left is the one that 
can be used as a reference while adjusting the image on the right. 
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I’ll select all of the images in Lightroom and then click on the Survey view icon so 
that I can view them all in the same window together. 

Looking at the images, I can tell that I’m not going to use all of them because 
there are a couple that look too similar to each other. I can also see that all of 
the trailers are photographed at an angle except for one, which was shot straight 
on. This is also the only picture that has a person in it. Because this one is a little 
different in that it’s not angled in some way and it has an element to pull you in, I 
think this image would work well as the centerpiece in the series. 

Now I’ll look at the other images and decide whether the angle of the trailers is 
going to direct the eye toward the right or to the left. This will determine whether 
they will go to the left or the right of that center image. Looking at the image of 
the blue and white trailer, my eye moves from left to right while looking at it. This 
tells me that it should be placed to the left of the center image so that it draws 
the viewer into the series. The angles of the dark pink trailer and the teal-colored 
trailer do the same thing. I will drag these images to the left side of the center 
image in this survey view. 

I selected a group of images that I thought would work well together and I clicked on the 
icon to view them in the Survey view. 
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The light pink trailer is angled 
downward to the left and my 
eye moves through the image 
from right to left. This tells me 
that this image would work 
well to the right of the center 
image because it draws the 
viewer into the series. 

At this point, I want to narrow down the images because I don’t want to print and 
hang all five images. I need to decide which image[s] don’t fit in as well with the 
others. I like that the blue and teal trailers both have cars, which creates some 
added interest. The dark pink trailer does not have a car, so I will remove that im-
age by clicking the X in the bottom right corner. The blue and teal trailer images 
are very similar, so I’m only going to keep one. There is no real reason to keep one 
rather than the other so it all comes down to personal preference here. I’m going 
to keep the blue trailer image so I will remove the image that contains the teal 
trailer. This leaves me with my series of three images. The center image is shot 
straight on, the left image angles to the right, drawing the eye into the middle, and 
the right image angles to the left, also drawing the eye into the middle. 

The arrows show the direction my eye moves through 
these images. 

This is the final 
sequence I decided 
on by determining 
which direction 
each image led me 
through the series. 
The three images 
on top draw me to 
the right. The bot-
tom left image is 
the central point 
and the bottom 
right image directs 
my eyes toward the 
left. 
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I’ll move back to the Grid view (by tapping the G key) and these three images will 
be the only ones that are selected. The left image, featuring the blue trailer, has a 
different sky color than the other two images so I will need to adjust it so that all 
three skies look similar. In this case, that image is a layered TIFF file, so I will need 
to adjust the image in Photoshop. 

In Photoshop, I could use either a Hue/Saturation adjustment layer or a Photo 
Filter adjustment layer to change the color of the sky so that it matches the other 
two images. I would also adjust the brightness of all three images so that they all 
have the same level of brightness. This will also help to make the images feel like 
a cohesive set. 

Note: There is another lesson on sequencing images for slideshows and that les-
son can also be useful for sequencing printed images.

These are the final three images I decided on, and they will be hung in this order on the wall.

A Hue/Saturation adjustment layer was 
used to change the color of the sky so 
that it better matches the other two 
images in the print series.



Print Sequencing © Ben Willmore, All rights reserved 14

These images are designed to be 
hung down a long hallway. This image 
would go on the far right because the 
angle of her body pulls the eye to the 
left and into the series.

This image will come next. It ties into 
the previous image because it shares 
the somewhat similar colors of blue 
and aqua. Her clothing is also black in 
both images.

This next image ties into the previous 
image because they both contain  
triangle shapes and she is again 
wearing black clothing.

Next up down the line, this image  
ties into the previous one because  
of the neutral beige color of the  
surroundings.

This image nicely follows the  
previous image because of the  
circular shapes in both images.

Another Sequencing Example:
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When to Print Large vs. Small (37:27)

Another thing to think about when planning to print is that some images are 
going to be best represented when printed really large. With other images, you 
can get away with printing them smaller. To determine which images need to be 
printed large vs. small, I find that it can be useful to look at the images as thumb-
nails, whether in Lightroom or a different program. If I can understand and enjoy 
an image as a small thumbnail, then I know I can get away with printing the image 
small. If, on the other hand, I cant understand or enjoy a print as a thumbnail, then 
I know that the image will likely need to be printed large in order for the viewer to 
enjoy it and really see what’s going on. 

To determine if an image needs to be print-
ed really large, I will look at the image set 
in a thumbnail view, as shown above. If I can 
understand an image from this small a size, I 
know I can get away with printing it small. If 
I can’t tell what’s going on, as with the image 
on the left, then I know it needs to be printed 
large. 


